
Update 10.0.6 & 10.0.7: The Easy Guide to Final Cut Pro X

This short update has been written to outline specific changes between the latest releases 
of Final Cut Pro X, versions 10.0.6 and 10.0.7, and those versions which went before it. 
The latest releases have brought several changes to the interface, changes to some of the 
menus, and a several new features. While much of the program is just the way it was (in 
fact less the five percent has changed) those areas which have changed are significant 
and have improved the workflow and usability of the application. It is clear that Apple has 
been working hard to bring the application to full professional level.

Interface Changes

Let us begin with changes to the interface. These are the most obvious of the changes.

(i) To ingest material from camera or card use to be done by 
pressing the camera icon located bottom left of the Event 
Browser. The camera icon has now changed to a filmstrip 
icon with arrow. This is sensible as the control is for 
bringing media into the application and not just for bringing 
in content from camera.

(ii) The Inspector Icon - this was previously labelled by the 
letter i - the symbol has now changed to one with horizontal 
lines and is now located second to the right just below the 
Inspector. Furthermore, a new icon has appeared 
immediately to the right - a large arrow - this is quick 
way to access the functionality of Share.

It should also be noted that the Share menu has now 
moved from having its own dedicated menu, to now 
being a command found under the File menu. 

So there are two ways to now 
access Share: one, to 
the right of the toolbar; 
two, from the File menu.
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(iii) It is also possible to open up a new Viewer window and work with dual Viewers. This 
will please many editors who have used the original Final Cut Pro, or other NLEs. The 
dual Viewer interface is useful in that is allows one to preview a clip in the Viewer to 
the left while matching to a shot which has been lined up in the the Timeline.

The second Viewer can be easily 
switched on and off by accessing the 
Window menu and selecting Show 
Event Viewer (shortcut - Control
+Command+3.)

It should be said, while this facility is 
welcome and useful, it is also useful 
(and very quick) to work with the single 
Viewer. This provides more real estate 
(very much needed in the FCPX 
interface) and an efficient means to 
toggle from where you are parked in 
the Timeline to being able to view 
content from the Event Library.

The option to work with dual Viewers 
provides the means to see shots side-
by-side which can be very useful for 
match frame editing, color correction and 
effects building. I use it when needed 
and switch it off the rest of the time.
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On the surface, that is it for interface changes. 

However, there are other significant changes, which will become clear, once you start 
accessing the functionality.

Unified Import Window

In versions of FCPX prior to 
10.0.6, bringing media from a 
camera or card would open a 
window titled the Camera Import 
Window This has now changed to a 
Window titled Media Import.

The workflow is very similar to what came 
before with the main difference being that 
everything is now imported through one area, accessing the same commands, regardless 
of whether you are importing from card, hard drive, or direct from camera. Previously there 
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was one way to bring media in from camera/card and another way to import media which 
already existed on hard drive. The processes for each of these was different.

Now, with the latest version, every time you import media into FCPX you will be greeted by 
the Media Import window. The process is a simple as selecting the hard drive, card, or 
device on the left, and then choose which media you wish to import.

Once the device and location have 
been defined choose Import 
Selected: the choices are the 
same as in previous versions of 
the software.

Whilst importing media there are 
improvements to the Range 
Selections - that is defining a 
portion of a clip which you wish to 
import. When bringing content in 
from card it is now possible to 
define sections within the clip to 
import (note: this is not possible 
when bringing in existing media 
from hard drive.) To define sections 
within a clip press the key 
combination:

Command + Shift + I to mark in or 
Command + Shift + O to mark the 

out point for a Range. Repeat the 
process to mark multiple ranges within 
clips on Import or for clips which already 
exist in the Event Browser.

This is extremely powerful as once you 
have marked the multiple ranges - for 
media existing in the Events Browser - 
you can then press F for Favorite or the 

Delete key for Reject, and 
then choose what to 
display in the Event 
Browser.
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Editing Enhancements

Most of the editing functionality is exactly the same as it was in previous versions. 
However, there are some significant improvements:

(i) As already discussed, dual Viewers, enabling side-by-side comparison of footage from 
the Event Library and that which is already in the Timeline. Press Control + Command 
+ 3 to toggle the Event Viewer on/off or select the menu from the top of the interface: 
Window - Show Event Viewer. 

This is particularly useful when comparing shots for color correction.

(ii) It is now possible to Blade through multiple clips - 
simply hold the Shift Key with the Blade Tool selected and 
this will then become a double Blade. The result is you can 
then slice through multiple clips at the same time. I 
absolutely love this feature!
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(iii) In and Out points marked within an Event now remain in place. Previously if you would 
click elsewhere in the Event Browser the Range you had marked in clips previously 
would disappear. Now the Range remains in place until you reset it. 

A Range can be reset by dragging the yellow ends in either direction or by pressing the 
letters “i” and “o” to mark a new range. The following commands will also reset the range:

! Reset “in” point - Option + I 

! Reset “out” point - Option + O
!
(iv) The behavior of the Playhead in the Timeline has been improved. Previously every 
time you clicked anywhere in the Timeline the Playhead would then be repositioned. Now 
it is only repositioned if you click in the gray area within the Timeline or ruler. Click on any 
of the clips and the Playhead stays in the position where you last left it.

(v) Improvements to Compound Clips - work has 
been done under the hood to ensure reliability of 

Compound Clips. These 
work better 
than ever 
now. When 
you create a 
Compound 
Clip you also 
create a 
Reference to the Compound Clip. You be prompted to define 
which Event you want the Reference to be placed within. The 
Compound Clip, within the Event, is defined by an icon top left. 
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The big advantage is that at any time you can then locate the Compound Clip and use this 
wherever you choose within your edit. You can also rename Compound Clips and these 
are searchable. 
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(vi) The menu to access Scopes is now 
found by selecting Window - Viewer 
Display - Show Video Scopes. The Scopes 
now appear beneath the Viewer. If you are 
working with twin Viewers then you can 
have both Viewers open with Scopes 
visible at the same time. This is a  great 
set-up for color correction.

Scopes can be positioned horizontally 
beneath the image or vertically, next to the  
image
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(vii) Freeze Frames - a new feature to enable 
the creation of a Freeze Frame is now 
available from within the edit menu 
(short cut Option + F). 

Essentially this will add a Freeze Frame to the 
point in the Timeline where the Playhead is 
positioned. The default length is 4 seconds, 
defined in Editing Preferences. You can choose 
this method or, another way to achieve a 
Freeze, is to select Hold from the Retiming tools 
(shortcut Shift + H).

(vii) Paste Attributes - a feature well-know from 
Final Cut Pro 7 and earlier versions, has now made 

its way back into FCPX. This 
incredibly useful function 
enables you to copy the 
attributes of a clip ie audio 
levels, changes to opacity, 
positioning, rotation etc and 
selectively apply the attribute or 
attributes to another clip or clips. 
This is very useful for when you 
wish to apply the same audio 
level across many clips, to copy 
and paste effects, or to position 
an image to a particular part of 
the frame. Simply Copy a clip in 
the Timeline (Command + C) 
and then choose Paste 
Attributes from the Edit menu. 
Choose the Attributes you wish 
to apply and select Paste.
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(ix) Set default 
Transition - control 
click any of the 
Transitions and 
select Make 
Default. Whenever 
you apply a 
transition the 
selected “default” 
transition which you 
have chosen will then be applied.

Audio Changes

Prior to the 10.0.6 release, there were several 
tools for working with audio: you could choose 
to Detach audio from video - making the audio 
truly independent from the video. To access the 
audio tracks within a single clip in the Timeline, 
where video and audio were combined, one 
could also choose to Break Apart Clip Items or 
the command Open in Timeline. 

For FCP versions 10.0.6 and later a new 
command is now offered: this is Expand Audio 
Components.

Expand Audio Components enables you to show the individual tracks which make up the 
audio. In the case below there are two separate audio tracks. This is commonly found with 
many cameras which feature twin XLRs and record 2 channels of audio.
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Choosing Expand Audio Components lets you see the separate audio tracks and you can 
then adjust the audio by keyframing or by increasing/reducing the volume within the 
individual tracks. 

You can also disable/enable audio tracks by pressing the letter V: this is a quick way to 
completely silence the audio of a particular track.

Double-click between the audio and video tracks to collapse the components or choose 
the menu at the top of the interface: 
Clip - Collapse Audio Components. You 
can quickly toggle Show Audio 
Components on/off by pressing the key 
combination: Control + Option + S.

Effects

Effects production in the later versions of Final Cut Pro X is largely the same as the 
previous version. The most notable change is that to controls for Transform, Crop and 
Distort are now accessed slightly differently.

Previously these controls 
were accessed bottom left 
of the Viewer - now these are still available in the 
same location, however, the individual functions are now accessed via a drop down menu. 
The rest of the operation remains the same.
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Another change worth pointing out is that no longer is 
Video Animation accessed by clicking the small triangle to 
the left of the each of the clips. This triangle has now 
disappeared. The shortcut Control + V will open Video 
Animation. This can also be accessed by control clicking 

on a clip and choosing Show 
Video Animation.

Also accessed via the Clip menu at the top of 
the interface.

For those using Final Cut Pro X 10.0.7 the Letterbox effect “Offset” slider is restored. This 
is an effect which existed in earlier versions of FCPX, which then disappeared with 10.0.6, 
and has now been brought back.
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Share

As mentioned earlier the Share menu no longer exists. The functionality has now been 
moved to two areas: the first is located beneath the File menu - choose Share; the other 
way is to click the arrow icon to the far right of the Toolbar. Either option does the same 
thing, which to let you choose from a selection of output options.

You have many choices, the most useful for the 
professional editor is to create Master file. Select this 
option and you can export in the codec in which you 
are currently working, or you can change to another 
codec.
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You can choose to output Video 
only, Audio only, or both Audio 
and Video.

At the bottom of the Share 
window, an estimation of file size 
is given. 

Define the location where you 
want the file to be stored and 
press Save.

The file is then written to disc 
and  the result is a high quality 
master which you can encode 
from or pass on for distribution.

You can also choose from the 
other options to create a file for 
YouTube, Vimeo, Facebook,  or 
DVD.

Other options exist which are 
hidden from view - choose Add Destination to reveal 
all the possible options, including Compressor Setting, 
BluRay, Image Sequence, and Save Current Frame.
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Share provides powerful means to encoding. Encoding is the key to getting your movie in 
front of its intended audience. Share gives us the means to achieve this.

Two other points worth closing on with regards to 
Share: when entering Markers into the Timeline 
you now have the option to include Chapter 
Markers for DVD authoring. On export you can 
choose to include the Chapter Markers. 

Beyond this you can also selectively export from the Timeline. Simply mark a range - when 
you choose Share only the Range will be exported.

In the complicated 
Timeline below the 
area defined in 
yellow will be 
exported including 
content both within the Primary Storyline and anything connected to it. Everything within 
these parameters, defined by the Range, will be included.

Conclusion

As written at the beginning of this piece the changes to Final Cut Pro X from the earlier 
version to FCPX 10.0.6 and 10.0.7 are significant, yet represent less that five percent of 
the software. In other words, most of the application is just the same as it was before. 
Regardless, five percent is significant, particularly when accessing particular functions and 
techniques which may have changed. Have fun editing with the latest version of FCPX. 
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